Geocentrix

Repute 2.5
Quick-Start Guide

Intelligent pile design and analysis

2

Geocentrix Repute 2.5 Quick-Start Guide

Information in this document is subject to change without notice and does not
represent a commitment on the part of Geocentrix Ltd. The software described in
this document is furnished under a licence agreement or non-disclosure agreement
and may be used or copied only in accordance with the terms of that agreement.
It is against the law to copy the software except as specifically allowed in the
licence or non-disclosure agreement. No part of this manual may be reproduced
or transmitted in any form or by any means, electronic or mechanical, including
photocopying and recording, for any purpose, without the express written
permission of Geocentrix Ltd.
©2002-20 Geocentrix Ltd. All rights reserved.
“Geocentrix” and “Repute” are registered trademarks of Geocentrix Ltd. Other
brand or product names are trademarks or registered trademarks of their
respective holders. PGroupN is used under exclusive licence from Geomarc Ltd.
PGROUP code used under licence from TRL Ltd.
Set in Optimum using Corel® WordPerfect® X7. Printed in the UK.

Acknowledgments
Repute 2.0 was developed with the generous support of Corus, Atkins, and Stent
Foundations. Repute 2.x was designed and written by Dr Andrew Bond of
Geocentrix, with the assistance of Ian Spencer of Honor Oak Systems.
PGroupN was designed and written by Dr Francesco Basile of Geomarc. Special
recognition goes to the late Dr Ken Fleming of Cementation Foundations Skanska
for his invaluable advice and support during the development of PGroupN.
The Repute Quick-Start Guide was written by Andrew Bond.
The following people assisted with the production of the program and its
documentation: Jenny Bond, Francesco Basile, Romain Arnould, Joe Bond, Tom
Bond, Halcrow Group, Jack Offord, and Claire Bond. The following generously
gave their time during initial beta testing: Francesco Basile and Dave Rowbottom.

Revision history
th

Last revised 16 October 2020 (for version 2.5.9).

Table of contents

3

TABLE OF CONTENTS
TABLE OF CONTENTS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3
INTRODUCING REPUTE 2.5. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
What’s new in Repute 2.5?
Documentation
Help system
Software Re-Assurance™
Notes

5
5
6
6
7
7

TUTORIAL 1
H-PILE IN CLAY AND SAND . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8
Overview
8
Step 1 – create the project
9
Step 2 – create the borehole
11
Step 3 – create the pile
12
Step 4 – create the force
14
Step 5 – create the calculations
15
Step 6 – perform and review the calculations
16
Step 7 – produce a report
18
Step 8 – close the project
19
What next?
19
TUTORIAL 2
FLEMING ’S HYPERBOLIC ANALYSIS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Overview
Step 1 – create the project information
Step 2 – create the ground conditions
Step 3 – create the pile
Step 4 – create the force
Step 5 – sleeve the pile
Step 6 – create the scenario and calculation
Step 7 – perform and review the calculation
Step 8 – close the project
What’s next?

20
20
21
22
23
24
24
24
25
26
27

TUTORIAL 3
SINGLE PILE DESIGN TO EUROCODE 7.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Overview
Step 1 – create the project
Step 2 – create the borehole
Step 3 – add a water table
Step 4 – create the pile

28
28
29
31
32
33

4

Geocentrix Repute 2.5 Quick-Start Guide
Step 5 – create the forces
Step 6 – create the calculation
Step 7 – customize the calculation
Step 8 – perform and review the calculations
Step 9 – change the design standard
What’s next?

34
35
36
38
39
41

TUTORIAL 4
PILE GROUP IN CLAY AND SAND .

....................................
Overview
Step 2 – create the pile group
Step 3 – create the borehole
Step 4 – enter the soils’ stiffness properties
Step 5 – create forces and moments
Step 6 – create the calculation
Step 7 – perform and review the calculation
Step 8 – produce a report
Step 9 – close the project
What’s next?

42
42
44
46
47
48
50
51
52
53
53

TUTORIAL 5
NON -LINEAR ANALYSIS OF PILE GROUP IN STIFF CLAY OVERLYING A RIGID LAYER .. .
Overview
Step 1 – create the project
Step 2 – create the pile group
Step 3 – create the soil
Step 4 – create a layer, borehole, and water table
Step 5 – create forces and moments
Step 6 – create the calculation
Step 7 – perform and review the calculation
Step 8 – export the results
Step 9 – close the project
What’s next?

54
55
55
56
59
60
62
63
63
64
65
65

TUTORIAL 6
ASYMMETRIC PILE GROUP UNDER 3D LOADING . . . . . . . . . . . . . . . . . . . . . . . . .
Overview
Step 1 – open and modify an existing project
Step 2 – specify a new pile group
Step 3 – move the piles to their final positions
Step 4 – modify the loads
Step 6 – close the project
What’s next?

66
67
67
68
71
72
75
75

Introducing Repute 2.5

5

INTRODUCING REPUTE 2.5
Repute® provides a rich set of capabilities for engineers to design/analyse:
!

various types of single pile, using current and historical design standards
(such as Eurocode 7 and BS 8004:2015)

!

pile groups under generalized 3-dimensional loading, using linear of nonlinear soil models

Repute considers single pile response using a variety of calculation methods for
ultimate and serviceability limit states. Both traditional lumped factors-of-safety and
modern partial factors can be applied in these calculations.
Repute analyses pile group behaviour using the boundary element method,
employing the leading analytical program PGroupN (developed by and included
under exclusive licence from Geomarc). PGroupN provides a complete 3D
non-linear boundary element solution of the soil continuum, which overcomes
limitations of traditional interaction-factor methods and gives more realistic
predictions of deformations and the load distribution between piles.

What’s new in Repute 2.5?
New features
!

Multi-threaded boundary element engine, up to 100x faster than before

!

Support for spun piles and micropiles

!

Action Import Wizard

!

Pile Group Import Wizard

!

Ability to chose which sections and materials appear in the Stockyard

!

Support for BS 8004:2015

!

Direct support for rock within the boundary element analysis

Improved features
!

Pile Group Wizard now supports a wider range of pile types

!

Greater distinction between different calculations in Stockyard

!

Updated Quick-Start Tutorial

!

Support for using the program across wide area networks
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!

Numerous other minor improvements

Documentation
Repute is supplied with a detailed Quick-start Guide, comprehensive User Manual,
and authoritative Reference Manual. The latest versions of these manuals (including
any corrections and/or additions since the program’s first release) are available in
electronic (Adobe® Acrobat®) format from the Geocentrix website.
(www.geocentrix.co.uk/repute and follow links to Repute’s documentation).

Quick-Start guide (this booklet)
The Repute 2.5 Quick-Start Guide includes six tutorials that show you how to use
the main features of Repute. Each tutorial provides step-by-step instructions on
how to drive the program. There are three tutorials dealing with single pile design
and three with pile group design. The tutorials increase in difficulty and are
designed to be followed in order.

User manual
The Repute 2.5 User Manual explains how to use Repute. It provides a detailed
description of the program’s user interface and explains how to employ it to
maximum effect.

Reference manual
The Repute 2.5 Reference Manual gives detailed information about the engineering
theory that underpins Repute’s calculations. The manual assumes you have a
working knowledge of the geotechnical design of single piles and pile groups, but
provides appropriate references for further study if you do not.

Help system
Repute’s help system contains detailed information about the program, including
most of the content of the Quick-Start Guide, User Manual, and Reference Manual
– plus additional information that is not found in any of these documents.
Help appears in a separate window to Repute, allowing you to view the help
topics while you continue to work with Repute itself. To open the help system:
!

Press F1

!

Click the Help button in any dialog box

!

Click on the Help button on the right hand side of Repute’s Ribbon

Introducing Repute 2.5
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Software Re-Assurance™
Software Re-Assurance for Repute (including updates, upgrades, and technical
support) is available direct from Geocentrix or through your local distributor. To
obtain Re-Assurance, contact Geocentrix as follows:
Repute Technical Support
Geocentrix Ltd
Scenic House, 54 Wilmot Way
Banstead, Surrey
SM7 2PY, United Kingdom
Please quote your licence number
and on all correspondence

T: +44 (0)1737 373963
E: support@geocentrix.co.uk
W: www.geocentrix.co.uk/support
Please be at your computer and have
your licence number ready when you
call

Notes
Screenshots in this guide were produced on Windows 10 (your screen may differ).
Not all options are available in every edition of Repute.
In this guide, ‘[Docs]’ refers to the folder where the documents that ship with
Repute were installed, typically here:
C:\Users\Public\Documents\Geocentrix\Repute\2.5
On Windows XP, replace:
C:\Users\Public\Documents
with:
C:\Documents and Settings\All Users\Shared Documents
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TUTORIAL 1
H-PILE IN CLAY AND SAND
This tutorial demonstrates the basic features of Repute, through a worked example
involving the analysis of a single H-pile installed in clay and sand:
!

Ground conditions comprise 5 m of clay overlying 20 m of dense sand.
3
The clay has unit weight of 20.5 kN/m , angle of shearing resistance of
23E, and undrained shear strength of 60 kPa. The sand has unit weight of
3
18 kN/m and angle of shearing resistance of 35E.

!

The foundation comprises a 305 x 305 x 110 H-pile of steel grade S275.

!

A vertical load of 700 kN is to be applied to the pile.

!

You want to determine the minimum length of pile needed to safely
carry the applied action according to traditional UK practice.

This tutorial is written for users of the Standard, Enterprise, and Trial Editions of
Repute only. Users of the Professional Edition should look at Tutorials 4-6.

Overview
!

In Step 1, you will use the Project Wizard to enter project information,
select a design standard, and create scenarios to represent short- and
long-term conditions.

!

In Step 2, you will use the Borehole Wizard to create a borehole
containing clay and sand layers.

!

In Step 3, you will create an H-pile and specify its cross-section and steel
grade.

!

In Step 4, you will create the force applied to the pile.

!

In Step 5, you will use the Calculation Wizard to create the calculations
you want Repute to perform.

!

In Step 6, you will perform the calculations and review the results.

!

In Step 7, you will produce a report summarising the results of the
calculations.

!

In Step 8, you will close (and optionally save) the project.

If Repute is not already running, double-click on the Repute icon on Windows’
Desktop to start the program. Once the splash screen has disappeared, Repute
displays its Welcome page.

Tutorial 1: H-pile in clay and sand
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If you have an existing project open, click Close on the program’s File menu. (You
will be prompted to save your work if you have not already done so.)

Step 1 – create the project
In Step 1, you will use the Project Wizard to enter project information, select a
design standard, and create scenarios to represent short- and long-term conditions.
1. Open the Project Wizard by
selecting the Wizards tab on
Repute’s ribbon and then clicking
on the Project Wizard button.
2. When the Wizard appears, type
“Tutorial 1” in the Project name
box. Choose the folder where
you want to save this project by using the Path control. (If you do not change
the setting here, it will be saved in your Documents folder.)
3. Enter “H-pile in clay and sand” in the Description box and “01” in the Project
ID box.

4. Click Next to display the next page (the standards that appear depend on
which edition of Repute you are running). Select BS 8004: 2015 by clicking on
the relevant checkbox (a tick mark appears when a standard is selected).
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5. Click Next to display the next page. Increase the Number of scenarios to 2
and then change the Design Situation of Scenario 1 to “Transient” but leave
Scenario 2 as “Persistent”.

6. Click Next to display the final page. If you wish to review any of the settings
you have made, click Back to return to the relevant page.
7. When you are ready, click Finish to generate the
project. The Project Wizard then:
!
!
!

Creates Site 1, Ground Surface 1, Design
Standard 1, and Situations 1-2
Adds Ground Surface 1 to Situations 1-2
Creates a new project named Tutorial
1.rpx with all these items

8. You can view these items by right-clicking anywhere
inside the Project Manager to display its context
menu and selecting the Expand All command. The
Project Manager will then look as shown in the picture alongside.
9. To view the properties of any particular item, select the item you want to
inspect in Repute’s Project Manager (e.g. Site 1)
10. Display the Property Inspector for the item by:
!
!

Right-clicking on the item, to display its context menu, and clicking the
Properties... command
Or ... Double-clicking on the item

Tutorial 1: H-pile in clay and sand
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11. Repute’s Property Inspector will open and
display the properties of the selected item. (For
example, for Site 1 the description is shown as
“H-pile in clay and sand” and the Project ID as
“01”.)
[Docs]\Tutorials\Tutorial 1\Step
1.rpx captures everything so far.

Step 2 – create the borehole
In Step 2, you will use the Borehole Wizard to create a borehole containing clay
and sand layers.
1. Open the Borehole Wizard by
selecting the Wizards tab on
Repute’s ribbon and then clicking on
the Borehole Wizard button.
2. When the Wizard appears, increase
the number of layers to 2.

3. Click Next to display the next page. Change Layer 1's thickness to 5m and its
soil type to “Clay”. Change the thickness of Layer 2 to 20m but leave its soil
type as “Sand”.

4. Click Next to display the next page. Change the Weight density (unit weight)
3
of Soil 1 to 20.5 kN/m and its Angle of shearing to 23E. Change the weight
3
density of Soil 2 to 18 kN/m and its angle of shearing to 35E. Leave the
Cohesion of both soils unchanged.
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5. Click Next to display the next page. Change the Strength of Soil 1 to 60 kPa.
Leave all other properties unchanged. (Note that Soil 2 does not appear on
this page, since it is a sand and so does not have undrained properties.)

6. Click Next to display the next page. Since the ground profile does not include
rock, there is nothing to set on this page.
7. Click Next to display the next page. Click All to select both
scenarios.
8. Click Next to display the next page. If you wish to review
any of the settings you have made, click Back to return to
the relevant page.
9. When you are ready, click Finish to generate the borehole.
The Borehole Wizard then:
!
!
!
!

Creates Soils 1-2, Layers 1-2, and Borehole 1
Links Soil 1 to Layer 1
Links Soil 2 to Layer 2
Adds Layers 1-2 to Borehole 1

[Docs]\Tutorials\Tutorial 1\Step 2.rpx captures everything so far.

Step 3 – create the pile
In Step 3, you will create an H-pile and specify its cross-section and steel grade.
1. Open the
Stockyard by
selecting the View
tab on Repute’s
ribbon and then
clicking on the
Construct button.
2. When the program has switched to its Construction Desktop (in which the
Drawing Board, Project Manager, and Stockyard are displayed), right-click

Tutorial 1: H-pile in clay and sand
anywhere inside the Stockyard to display its context menu and select the
Bearing Piles command. The Bearing Piles group will open.
3. Create the section by selecting the item labelled
“UKBP 305x305x95”, right-clicking to display its
context menu, and then selecting the command
Create ‘UKBP 305x305x95’. The newly-created
hot-rolled section will appear in the Project
Manager (under Sections).
4. Next, right-click anywhere inside the Stockyard
to display its context menu and select the Steels
command. The Steels group will open.
5. Create the steel by holding the Ctrl key down
and clicking on the item labelled “S275”. (When
the Ctrl key is pressed, Repute automatically
creates any item that you select in the
Stockyard. This saves you the effort of displaying
the popup menu each time you want to create
a new item.) The newly-created steel will appear
in the Project Manager (under Materials).
6. Finally, click on the Stockyard’s Structural
Elements caption (near the bottom of the
Stockyard). The Structural Elements panel will
open.
7. Create the pile by holding the Ctrl key down
and clicking on the item labelled “H-pile”. The
newly-created pile will appear in the Project
Manager (under Structural Elements).
8. In the Project Manager, right-click on the newlycreated pile (“Pile 1”) to display its context
menu and select the Properties... command.
The Property Inspector will appear.
9. In the Property Inspector, change the Material
Name (under Material Properties) from “Not
specified” to “Steel 1”. Then change the Section
Name (under Section Properties) from “Not
specified” to “Section 1”. Leave all other
properties of the pile unchanged.
10. Returning to the Project Manager, select
Situation 1 (under Scenarios).
11. In the Property Inspector, place a tick next to
Pile 1 (under Structural Elements) to add the
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pile to this scenario. The Drawing Board will refresh.

12. Repeat the previous two instructions for Situation 2.
13. In this step, you have:
!
!
!

Created Section 1, Steel 1, and Pile 1
Linked Section 1 and Steel 1 to Pile 1
Added Pile 1 to Situations 1 and 2

The Drawing Board will now look something like this:

[Docs]\Tutorials\Tutorial 1\Step 3.rpx captures everything so far.

Step 4 – create the force
In Step 4, you will create the force applied to the pile.
1. Open the Stockyard’s
Actions panel by selecting
the Insert tab on Repute’s
ribbon and then clicking
on the Action button.
2. The Actions group will
open in the Stockyard.
Hold the Ctrl key down and click on the item
labelled “Force”.
3. The newly-created force will appear in the
Project Manager (under Actions).
4. In the Property Inspector, change the
Variability of Force 1 (under Options) to
“Permanent” and the value of Fz (under
Components of Action) to 700 kN. The
Resultant will automatically change to 700 kN.
5. Change the Tether to ... item to “Pile 1”. This

Tutorial 1: H-pile in clay and sand
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will ensure that the force’s plan position will always match the pile’s plan
position, even if the pile is moved.
6. In the Project Manager, select “Situation 1” (under Scenarios).
7. In the Property Inspector, place a tick next to Force 1 (under Actions) to add
the action to this scenario. The Drawing Board will refresh and now look like
this:

8. Repeat the previous two instructions for Situation 2.
9. In this step, you have:
!
!

Created Force 1
Added Force 1 to Situations 1 and 2

This file at [Docs]\Tutorials\Tutorial 1\Step 4.rpx captures
everything so far.

Step 5 – create the calculations
In Step 5, you will use the Calculation Wizard to create the calculations you want
to perform.
1. Open the Calculation Wizard by selecting the Wizards tab on Repute’s
ribbon and then clicking on the Calculation Wizard button.
2. When the Wizard appears, select “Longitudinal ULS”. (The calculations that
appear here depend on which edition of Repute you are running.)

3. Click Next to display the next page. Select “Design Standard 1” (this is the
BS 8004:2015 design standard created in Step 1 of this tutorial).
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4. Click Next to display the next page. Click All to select both situations.
5. Click Next to display the final page. If you wish to review any of the settings
you have made, click Back to return to the relevant page.
6. When you are ready, click Finish to generate the calculations. The Calculation
Wizard then:
!
!
!
!

Creates Calculations 1-2
Links Situation 1 to Calculation 1
Links Situation 2 to Calculation 2
Links Design Standard 1 to Calculations 1-2

[Docs]\Tutorials\Tutorial 1\Step 5.rpx captures everything so far.

Step 6 – perform and review the calculations
In Step 6, you will perform the calculations and review the results.
1. Run the calculation by
selecting the Build tab
on Repute’s ribbon and
then clicking on the
Run All button.
2. Repute will perform all
the calculations that
you have specified (i.e. Calculations 1 and 2) and then change
to its Checking Desktop (which displays the Workbook and
Graph Paper). You can switch to this display at any time by
clicking on the Check button on the View tab of Repute’s
ribbon.
3. Your screen will now look something like this:

Tutorial 1: H-pile in clay and sand
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4. The Graph Paper (top right panel) shows:
!
!
!

effect of the actions E (the sum of the applied forces and the self-weight
of the pile) increasing slightly with depth
separate components of shaft and base resistances, Rs and Rb
the total compressive resistance, Rc = Rs + Rb, exceeding the effect of
actions (E # Rc) at a depth between 13.5 and 14.5 m (depending on
which calculation is displayed)

5. The Workbook (top left panel) shows the same
information, but in tabular format. The
Workbook contains a lot more information than
is initially shown. To display this additional
information, click on the button labelled ‘*’ in
the top-left-hand corner of the Workbook (to
the left of the heading ‘Depth’) and select the
data you want to see.
6. To view the results of the second calculation,
select Calculation 2 in the Project Manager.
Repute will automatically update the Workbook
and Graph Paper with this calculation’s data.
(To display the Project Manager, select the
View tab on Repute’s ribbon and then click on
the Project Manager button.)
[Docs]\Tutorials\Tutorial 1\Step
6.rpx captures everything so far.
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Step 7 – produce a report
In Step 7, you will produce a report summarising the calculations.
1. Display Repute’s reporting tools by
selecting the View tab on Repute’s
ribbon and then clicking on the
Review button.
2. Next, create a report by selecting
the Reporter tab on Repute’s
ribbon and clicking on the Refresh
button.
3. Repute will generate the requested report and
display it, together with a set of thumbnails, in the
Reporter.

4. You can navigate around
the report using the
controls on the Reporter
tab on Repute’s ribbon:
First Page, Previous Page,
Next Page, and Last Page. You can jump to specific pages by clicking on the
thumbnails on the left-hand side of the Reporter.
5. You can also re-size the report using the Fit Width, Fit Height, Zoom In, and
Zoom Out controls.
6. You can choose what to include in
your report by selecting or
deselecting individual items in the
Report Elements group, then
clicking the Refresh button.

Tutorial 1: H-pile in clay and sand
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7. You can edit the report’s layout using the Modify command
(this is only available in the Enterprise Edition of the program).
8. You must close this window in order to return to Repute. You
can do this by going to File and then selecting Exit.
9. Finally, you can output the report onto paper using the Print command and
choosing from the options provided in the dialog box that appears on your
screen. (Note: this is not available in the Trial Edition.)

Step 8 – close the project
In Step 8, you will close and – optionally – save the project. (Note: this is not
available in the Trial Edition.)
1. Close the project by clicking on the File menu’s Close command.
2. If you have made changes to the project since it was last saved, Repute will
ask you if you want to save before proceeding. Answer Yes or No by clicking
the appropriate button.
3. Repute will then (if requested) save and close the project.
[Docs]\Tutorials\Tutorial 1\Tutorial 1.rpx. captures everything in
this tutorial.

What next?
Tutorial 2 shows you how to set up Fleming’s hyperbolic analysis.
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TUTORIAL 2
FLEMING’S HYPERBOLIC ANALYSIS
Tutorial 2 shows you how to construct a load vs displacement curve for a single
pile, using Fleming’s hyperbolic analysis, described in his 1992 Géotechnique
paper “A new method for single pile settlement prediction and analysis” (see vol.
42, no. 3, pp 411-425). This tutorial demonstrates how to setup a calculation in
Repute without using the program’s built-in wizards, thereby showing you how
versatile the program’s user interface is.
The worked example is taken from Figure 6 in Fleming’s paper, which is based
upon from tests carried out at Wembley by Whitaker & Cooke. We are interested
in replicating the load vs displacement curve given by Fleming’s analysis.
!

Ground conditions at the site are not given in the paper, so we will
assume 25m of London Clay with an undrained strength of 100 kPa and
an angle of shearing resistance of 23E.

!

The pile studied is a 12.2 m long, 775 mm diameter bored pile made of
concrete with Young’s modulus equal to 19.5 GPa.

!

A vertical load of 200 tonnes (approximately 2000 kN) is applied at the
centre of the pile.

!

The ultimate load that the pile can carry has been calculated (separately)
as 1994 kN on the shaft and 1002 kN from the base. The soil modulus
below the pile base is 33.125 MPa. Other parameters used by Fleming
are the shaft flexibility factor (0.0017 or 0.17%) and effective column
length factor (0.45).

This tutorial is written for users of the Standard, Enterprise, and Trial Editions of
Repute only. Users of the Professional Edition should look at Tutorials 4-6.

Overview
!

In Step 1, you will enter project information about the site and the
Engineer.

!

In Step 2, you will define the site’s ground conditions.

!

In Step 3, you will create a bored pile and specify its cross-section and
concrete grade.

!

In Step 4, you will create the force applied to the pile.

!

In Step 5, you will sleeve the pile through the made ground.

!

In Step 6, you will create the scenario and calculation and link various

Tutorial 2: Fleming’s hyperbolic analysis
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items together.
!

In Step 7, you will perform the calculation and produce a report showing
the relationship between load and displacement.

!

In Step 8, you will close (and optionally save) the project.

If Repute is not already running, double-click on the Repute icon on Windows’
Desktop to start the program. Once the splash screen has disappeared, Repute
displays its Welcome page.
If you have an existing project open, click Close on the program’s Application
menu. You will be prompted to save your work if you have not already done so.

Step 1 – create the project information
In Step 1, you will enter project information about the site and the Engineer.
1. Click New on the program’s File menu to
create a blank project. Alternatively, click
on the New button on the Quick-access
toolbar, located on the right-hand side of
Repute’s icon in the tile bar.
2. Open the Stockyard’s Project Information
group by selecting the Insert tab on
Repute’s ribbon and then clicking on the Project
Information button. The Project Information group will
open in the Stockyard.
3. Hold the Ctrl key down and click on the item labelled
“Construction Site”. A newly-created site will appear in
the Project Manager (under Project Information).
4. In the Project Manager, double-click on the
newly-created site (“Site 1”) to open its Property
Inspector.
5. In the Property Inspector, change the Name to
“Wembley”.
6. Enter “Fleming’s Hyperbolic Analysis” in the
Description box and click OK to confirm what
you have typed.
7. Enter “Fig. 6” in the Project ID box.
8. Returning to the Stockyard, create a Party by holding down the Ctrl key and
clicking on the item labelled “Party”. A newly-created party will appear in the
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Project Manager (under Project Information) as “Party 1” and the Property
Inspector will display its default properties.

9. In the Property Inspector, change the Name of the newly-created party to
“Whitaker and Cooke” and their role to “Engineer” (if not already selected).
[Docs]\Tutorials\Tutorial 2\Step 1.rpx captures everything so far.

Step 2 – create the ground conditions
In Step 2, you will define the site’s ground conditions.
1. Returning to the Stockyard, click on the button labelled Common to open the
Common group, where you will find (amongst other items) Plane Ground.
2. Hold the Ctrl key down and click on the item
labelled “Plane Ground” to create it.
3. In the Property Inspector, change the Name
“Ground Surface 1” to “Horizontal Ground” but
leave the other (default) properties unchanged.
4. Back in the Stockyard, open the Grounds group
so that you can create a Clay. You may need to
click one of the small buttons at the bottom of
the Stockyard to display this group. You can
move the mouse over each button in turn to
display a tooltip indicating which panels they
control. Create the Clay by Ctrl-clicking on it.
5. In the Property Inspector, change the Name of
the new Clay to “London Clay”, and enter the
following properties: under the heading Drained
Strength, Angle of shearing resistance = 23E;
under Undrained strength, Undrained strength
= 100 kPa.
6. In the Stockyard, open the Geotechnical Constituents group and create both a
Soil Layer and a Borehole.
7. Select the layer in the Project Manager and then (in the Property Inspector)
change its Name to “Clay Layer”, its Thickness to 25 m, and select “London
Clay” in its Soil box, under the heading Material.
8. Now select the borehole in the Project Manager and the, in the Property
Inspector, rename it “Wembley Borehole”. Next, press the Select... button.
9. In the dialog box that appears, click on the >> button to move “Clay Layer”
from the Available layers box to the Selected layers box. Click OK to confirm
the changes.
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[Docs]\Tutorials\Tutorial 2\Step 2.rpx captures everything so far.

Step 3 – create the pile
In Step 3, you will create a bored pile and specify its cross-section and concrete
grade.
1. Open the Concretes group in the Stockyard and
create a concrete of grade C35/45.
2. In the Property Inspector, attempt to change
the Young’s modulus (E) of the new concrete
to 19.5 GPa. When you press ENTER, the value
will revert back to 34.08 GPa and the Message
Board will open to reveal the error message
“Young’s modulus must be >= 25 GPa and <=
44 GPa for ‘Concrete 1’. Value entered = 19.5 GPa”. Since the value of
Young’s modulus used by Fleming is outside the allowable range for Grade
Concrete, we need to use a Custom Concrete instead.

3. Back in the Concretes panel, create a Custom Concrete. Then set its Young’s
modulus (E) to 19.5 GPa (this should succeed) and change its Name to
“Fleming’s concrete”.
4. Because we no longer need the Grade Concrete, we can delete it from the
project by right-clicking on ‘Concrete 1’ in the Project Manager and selecting
Edit > Delete. When prompted, confirm that you want to delete ‘Concrete 1
(Grade Concrete)’.
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5. Open the Structural Elements group in the Stockyard and create a Bored Pile.
6. In the Property Inspector, change the Length of the new pile to 12.2 m and its
Shaft diameter to 775 mm (its base diameter will automatically increase to
775 mm). Finally, select “Fleming’s concrete” in the box Material name.
[Docs]\Tutorials\Tutorial 2\Step 3.rpx captures everything so far.

Step 4 – create the force
In Step 4, you will create the force applied to the pile.
1. Open the Actions group in the Stockyard and
create a Force.
2. In the Property Inspector, change the
Variability (under Options) of the new force to
“Permanent”
3. Change Fz (under Components of action) to
2000 kN, whereupon the Resultant will
automatically change to 2000 kN.
[Docs]\Tutorials\Tutorial 2\Step
4.rpx captures everything so far.

Step 5 – sleeve the pile
In Step 5, you will sleeve the pile through the made ground.
1. Open the Algorithms group in the Stockyard
and create a No contact algorithm.
2. In the Property Inspector, change the Name of
the new algorithm to “Length in made ground”
and Custom depth to 1.4 m. The Algorithm
Option will automatically change to “Custom
depth”. In the example calculation, the No
contact depth will also change to 1.4 m (which
is depth of ground that the calculation will
ignore when calculating skin friction).
[Docs]\Tutorials\Tutorial 2\Step 5.rpx captures everything so far.

Step 6 – create the scenario and calculation
In Step 6, you will create the scenario and calculation and link various items
together.
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1. Open the Scenarios group in the Stockyard and
create a Situation.
2. In the Property Inspector, change the scenario’s
Duration to “Transient”. Then, tick the following
items so that they appear in this scenario (as
you do so, they will appear on the Drawing
Board):
!
!
!
!

Wembley Borehole
Pile 1
Horizontal Ground
Force 1

3. Open the Calculations group in the Stockyard and create Fleming’s Analysis.
4. In the Property Inspector, set the Scenario to “Situation 1” and the No
contact algorithm to “Length in made ground”.
5. Enter the following values for the calculation’s
other properties: Ultimate shaft load (Us) 1994
kN; Ultimate base load (Ub) 1002 kN; Base
stiffness (Eb) 33.125 MPa; Shaft flexibility (Ms)
0.17%; and Effective column length (Ke) 0.45.
These values are taken directly from Fleming’s
paper.
6. Finally, set the Maximum settlement ratio to
1%. This controls how much of the load vs
displacement curve is generated. You want to
go up to about 8 mm displacement, which is
1% of the pile diameter.
[Docs]\Tutorials\Tutorial 2\Step 6.rpx captures everything so far.

Step 7 – perform and review the calculation
In Step 7, you will perform the calculation and produce a report showing the
relationship between load and displacement.
1. Run the calculation by selecting the
Build tab on Repute’s ribbon and then
clicking on the button labelled Run
Calculation 1.
2. Repute performs the calculation and
then changes to its Checking Desktop
(which displays the Workbook and Graph Paper).
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3. Your screen will now look something like this:

4. The Graph Paper displays a graph which is almost identical to Figure 6 in
Fleming’s paper, showing:
!
!
!

Base load vs displacement (in blue)
Shaft load vs displacement (in pink)
Total load vs displacement (in green)

5. You can view the data on which this graph is based in the Workbook (left).

Step 8 – close the project
In Step 8, you will close and – optionally – save the project. (Note: this is not
available in the Trial Edition.)
1. Click on the program’s File menu and click Close.
2. If you have made changes to the project since it was last saved, Repute will
ask you if you want to save it before proceeding. Answer Yes or No by
clicking the appropriate button.

3. Repute will then (if requested) save and close the project.
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[Docs]\Tutorials\Tutorial 2\Tutorial 2.rpx captures the
everything in this tutorial.
A Repute project which reproduces all nine hyperbolic analyses from of Fleming’s
paper can be found in [Docs]\Examples\Fleming (1992).rpx.

What’s next?
Tutorial 3 shows you how to design a single pile in accordance with the
requirements of Eurocode 7.
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TUTORIAL 3
SINGLE PILE DESIGN TO EUROCODE 7
Tutorial 3 shows you how to design a single pile according to the requirements of
Eurocode 7. The worked example is taken from Chapter 13 of the book
“Decoding Eurocode 7” by Bond and Harris (2008), London: Taylor and Francis.
!

Ground conditions comprise 8 m of medium strength sandy CLAY
overlying medium dense gravelly SAND. The clay has characteristic
undrained strength of 45 kPa and characteristic weight density of 18.5
3
kN/m . The sand a characteristic angle of shearing resistance of 36E,
3
zero effective cohesion, and characteristic weight density of 20 kN/m .
The sand’s constant-volume angle of shearing-resistance is 33E.

!

Groundwater at the site is at 1 m depth and skin friction above
groundwater will be ignored.

!

The pile studied is a 10 m long, 400 mm square pile made of concrete
3
with characteristic weight density of 25 kN/m .

!

Vertical loads of 650 kN (permanent) and 250 kN (variable) will be
applied to the pile.

!

You want to determine the minimum pile length required by Eurocode 7
according to the National Annexes published in Ireland and in the
United Kingdom.

Full hand calculations for this example are given as Examples 13.1 and 13.2 in
Bond and Harris (2008).
This tutorial is written for users of the Standard, Enterprise, and Trial Editions of
Repute only. Users of the Professional Edition should look at Tutorials 4-6.

Overview
!

In Step 1, you will use the Project Wizard to enter project information,
select design standards, and create a scenario to represent short-term
conditions.

!

In Step 2, you will use the Borehole Wizard to create a borehole
containing the clay and sand layers.

!

In Step 3, you will add a water table to the scenario.

!

In Step 4, you will create a pile and specify its cross-section and
concrete grade.

!

In Step 5, you will use the Action Wizard to create the forces applied to
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the pile.
!

In Step 6, you will use the Calculation Wizard to create a calculation and
specify the design standard to use in that calculation.

!

In Step 7, you will specify precise details of how you want the
calculation to be performed.

!

In Step 8, you will perform the calculations and review the results.

!

In Step 9, you will create a second calculation, identical to the first but
based on the UK National Annex to Eurocode 7.

!

In Step 10, you will close (and optionally save) the project.

If Repute is not already running, double-click on the Repute icon on Windows’
Desktop to start the program. Once the splash screen has disappeared, Repute
displays its Welcome page.
If you have an existing project open, click Close on the program’s File menu. (You
will be prompted to save your work if you have not already done so.)

Step 1 – create the project
In Step 1, you will use the Project Wizard to enter project information, select
design standards, and create a scenario to represent short-term conditions.
1. Open the Project Wizard by selecting
the Wizards tab on Repute’s ribbon
and then clicking on the Project
Wizard button.
2. When the Wizard appears, type
“Tutorial 3“ in the Project name box.
Choose the folder where you want to save this project by using the Path
control – for example, ‘Repute Projects’, which you could create using
Windows’ File Explorer. (If you do not change the setting here, it will be saved
in your ‘Documents’ folder.)
3. Enter “Single pile design to Eurocode 7” in the Description box and “03” in
the Project ID box.
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4. Click Next to display the next page. The design standards that appear here
depend on which edition of Repute you are running (the Enterprise Edition
supports more design standards than the Standard and Professional editions).
5. Select BS EN 1997-1: 2004 and IS EN 1997-1:2005 by clicking on the relevant
check-boxes (a tick mark appears next to a standard when it is selected).

6. Click Next to display the next page. Keep the Number of scenarios as 1, but
change the Design Situation of Scenario 1 to “Transient”.

7. Click Next to display the final page. If you wish to review any of the settings
you have made, click Back to return to the relevant page.
8. Click Finish to generate the project. The Project Wizard then:
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Creates Site 1, Ground Surface 1, Design Standards 1 and 2, and
Situation 1
Adds Ground Surface 1 to Situation 1
Creates a new project named Tutorial 3.rpx with all these items

9. Finally, rename the design standards to make it easier to identify them later, as
follows. Locate Design Standard 1 (under “Design Standards > Limit State
Standards”) in the Project Manager, right-click on it, and select Properties.
The Property Inspector will appear. Change the Name of this standard to “EC7
with UK NA”.
10. Repeat the previous step for Design Standard 2, renaming it “EC7 with Irish
NA”.
[Docs]\Tutorials\Tutorial 3\Step 1.rpx captures everything so far.

Step 2 – create the borehole
In Step 2, you will use the Borehole Wizard to create a borehole containing the
clay and sand layers.
1. Open the Borehole Wizard by
selecting the Wizards tab on
Repute’s ribbon and then clicking on
the Borehole Wizard button.
2. When the Wizard appears, increase
the number of layers to 2.

3. Click Next to display the next page. Change Layer 1’s Thickness to 8 m and its
Soil type to “Clay”. Change the thickness of Layer 2 to 5 m but leave its soil
type as “Sand”.

4. Click Next to display the next page. Change the Weight density of Soil 1 to
3
18.5 kN/m but leave its other properties unchanged. Change the Angle of
shearing of Soil 2 to 36E but leave its other properties unchanged.
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5. Click Next to display the next page. Change the Strength of Soil 1 to 45 kPa.
Leave all other properties unchanged. (Note that Soil 2 does not appear on
this page, since sand is a fine soil and so does not have undrained properties.)

6. Click Next to display the next page. Since the ground profile does not include
rock, there is nothing to set on this page.
7. Click Next to display the next page. Place a tick in the checkbox for Situation
1.
8. Click Next to display the final page. If you wish to review any of the settings
you have made, click Back to return to the relevant page.
9. Click Finish to generate the borehole. The Borehole Wizard then:
!
!
!
!

Creates Soils 1 and 2, Layers 1 and 2, and Borehole 1
Links Soil 1 to Layer 1
Links Soil 2 to Layer 2
Adds Layers 1and 2 to Borehole 1

[Docs]\Tutorials\Tutorial 3\Step 2.rpx captures everything so far.

Step 3 – add a water table
In Step 3, you will add a water table to the scenario.
1. Open the Stockyard’s Geotechnical
Constituents panel by selecting the Insert tab
on Repute’s ribbon and then clicking on the
Geotechnical Constituents button. The
Geotechnical Constituents panel will open in
the Stockyard.
2. Hold the Ctrl key down and click on the
item labelled “Ground Water Table”. The newly-created water table will
appear in the Project Manager (under Geotechnical Constituents > Water
Tables).
3. In the Property Inspector, change the Depth of Water Table 1 (which you will
find under Location > Relative Position) to 1 m.
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4. In the Project Manager, select “Situation 1” (under Scenarios > Situations).
5. In the Property Inspector, place a tick next to Water Table 1 (under
Geotechnical Constituents) to add the water table to this scenario. The
Drawing Board will refresh.
6. In this step, you have:
!
!

Created Water Table 1
Added Water Table 1 to Situation 1

[Docs]\Tutorials\Tutorial 3\Step 3.rpx captures everything so far.

Step 4 – create the pile
In Step 4, you will create a pile and specify its cross-section and concrete grade.
1. Display Repute’s Construct
desktop by selecting the View
tab and clicking on the
Construct button. The program
will display the Drawing Board,
Project Manager, and Stockyard.
2. Right-click anywhere inside the Stockyard to display its context menu and
select the Concretes command. The Concretes group will open.
3. Create the concrete by holding the Ctrl key down and clicking on the item
labelled “C30/37”. (When the Ctrl key is pressed, Repute automatically
creates an instance of the item that is selected in the Stockyard.) The newlycreated concrete will appear in the Project Manager (under Materials >
Concretes).
4. Next, click on the Stockyard’s Structural Elements caption (near the bottom of
the Stockyard). The Structural Elements group will open.
5. Create the pile by holding the Ctrl key down
and clicking on the item labelled “Square Pile”.
The newly-created pile will appear in the Project
Manager (under Structural Elements).
6. In the Project Manager, right-click on the newlycreated pile (“Pile 1”) and select Properties....
The Property Inspector will appear.
7. In the Property Inspector, change the Material
Name (under Material Properties) from “Not
specified” to “Concrete 1”. Then change the
pile’s Length (under Dimensions) to 10 m and

34

Geocentrix Repute 2.5 Quick-Start Guide
its Breadth (under Section Properties) to 400 mm. Leave all other properties of
the pile unchanged.

8. Returning to the Project Manager, select Situation 1 (under Scenarios >
Situation).
9. In the Property Inspector, place a tick next to Pile 1 (under Structural
Elements) to add the pile to this scenario. The Drawing Board will refresh.
10. In this step, you have:
!
!
!

Created Concrete 1 and Pile 1
Linked Concrete 1 to Pile 1
Added Pile 1 to Situation 1

[Docs]\Tutorials\Tutorial 3\Step 4.rpx captures everything so far.

Step 5 – create the forces
In Step 5, you will use the Action Wizard to create the forces applied to the pile.
1. Open the Action Wizard by selecting
the Wizards tab on Repute’s ribbon
and clicking on the Action Wizard
button.
2. When the Wizard appears, increase
the No. of forces to 2; “Force 1” and
“Force 2” will be created.
3. Set the Fz value for Force 1 to 650 kN and change its Variability to
“Permanent”.
4. Then set the Fz value for Force 2 to 250 kN but keep its Variability as
“Variable”.

5. Click Next to display the next page. Since no moments are applied to the pile,
leave the number of moments as 0.
6. Click Next to display the next page. Increase the No. of combinations to 1;
“Combination 1” will be created. Under the column Forces to include..., tick
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Force 1 and Force 2.

7. Click Next to display the last page. If you wish to review any of the settings
you have made, click Back to return to the relevant page.
8. Click Finish to generate the actions and their combination. The Actions
Wizard will then:
!
!
!

Create Forces 1 and 2
Create Combination 1
Add Forces 1 and 2 to Combination 1

9. Returning to the Project Manager, select Situation 1 (under Scenarios >
Situations).
10. Then, in the Property Inspector, place a tick next to Combination 1 (under
Actions) to add the combination to this scenario. The Drawing Board will
refresh.
[Docs]\Tutorials\Tutorial 3\Step 5.rpx captures everything so far.

Step 6 – create the calculation
In Step 6, you will use the Calculation Wizard to create a calculation and specify
the design standard to use in that calculation.
1. Open the Calculation Wizard by selecting the Wizards tab on Repute’s
ribbon and then clicking on the Calculation Wizard button.
2. When the Wizard appears, select “Longitudinal ULS”. (The calculations that
appear here depend on which edition of Repute you are running. The
Enterprise Edition provides more calculations than the Standard and
Professional editions.)
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3. Click Next to display the next page. Select “EC7 with Irish NA”.

4. Click Next to display the next page. Place a tick in the checkbox next to
Situation 1.
5. Click Next to display the final page. If you wish to review any of the settings
you have made, click Back to return to the relevant page.
6. When you are ready, click Finish to generate the first calculation. The
Calculation Wizard then:
!
!
!

Creates Calculation 1
Links Situation 1 to Calculation 1
Links “EC7 with Irish NA” to Calculation 1

[Docs]\Tutorials\Tutorial 3\Step 6.rpx captures everything so far.

Step 7 – customize the calculation
In Step 7, you will specify precise details of how the calculation is to be
performed, following the decisions made by Bond and Harris, 2008.
1. Open the Stockyard’s Algorithms group by selecting the Insert tab on
Repute’s ribbon and then clicking on the Algorithm button.

2. Hold the CTRL key down and click on “No contact algorithm” in the
Stockyard. Then, in the Property Inspector, change the Name of the new
algorithm to “No skin friction” and enter “Ignore skin friction above water
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table” in its Notes field. Enter a value of 1.0 m into the Custom depth box,
whereupon the Algorithm Option will automatically change to “Custom
depth”.
3. Hold the CTRL key down and click on “Alpha”
in the Stockyard. Change the Name of the new
algorithm to “Alpha in clay” and enter “From US
Army Corps of Engineers” in its Notes field.
Enter a value of 0.8 into the Custom alpha box,
whereupon the Option will automatically
change to “Custom alpha”.
4. Hold the CTRL key down and click on “Earth pressure coefficient” in the
Stockyard. Change the Name of the new algorithm to “Ks in sand” and enter
“= Nq/50” in its Notes field. Enter a value of 1.59 into the Custom
compression coefficient box, whereupon the Option will automatically
change to “Custom earth pressure coefficient”.
5. Hold the CTRL key down and click on “Wall friction” in the Stockyard.
Change the Name of the new algorithm to “Delta in sand” and enter “=
constant volume angle of shearing resistance” in its Notes field. Enter a value
of 33E into the Custom friction value box, whereupon the Option will
automatically change to “Custom friction value”.
6. Hold the CTRL key down and click on “Bearing capacity algorithm” in the
Stockyard. Change the Name of the new algorithm to “Nq in sand”. Change
the Option to Berezantzev. In the Example Calculation group, change the
Angle of shearing resistance to 35° and the Slenderness ratio to 25. The
value of Nq will update (to 47.23), while Nc is not specified (since
Berezantzev’s algorithms is only applicable to sands).
7. Select “Calculation 1” in the Project Manager.
8. In the Property Inspector, set a link to the
bearing capacity algorithm you have just
created by clicking on the down arrow to the
right of the heading Bearing Capacity Factor
and selecting ‘Nq in sand’.
9. Repeat the previous instruction for the other
algorithms you have created (i.e. Wall friction,
Earth pressure coefficient, Alpha, and
Shrinkage).
10. Also tick the Undrained resistance option to
ensure that the calculation is based on total
stresses in the clay.
[Docs]\Tutorials\Tutorial 3\Step 7.rpx captures everything so far.
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Step 8 – perform and review the calculations
In Step 8, you will perform the calculation and review the results.
1. Run the calculation by selecting the
Build tab on Repute’s ribbon and
then clicking on the Run Calculation
1 button.
2. Repute will perform the specified
calculation and then change to its
Check Desktop (which displays the
Workbook and Graph Paper). Your screen will now look something like:

3. The Graph Paper (top right panel) shows the:
!
!
!

Effect of actions (E, equal to the sum of the applied forces and the selfweight of the pile) increasing with depth
Separate components of tensile resistance (Rt), base resistance (Rb), and
shaft resistance (Rs) also increasing with depth
The total compressive resistance (Rc = Rs + Rb) exceeding the effect of
actions (E # Rc) at a depth between 11 and 12 m

4. The Workbook (top left panel) shows the same information in tabular format.
The Workbook contains a lot more information than is initially shown. To
display this additional information, click on the button in the top-left-hand
corner (labelled *) and select the data you want to see. The picture here show
results for the depth 10 m.
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5. The results calculated by Repute differ from
those given in the book by Bond and Harris
(2008), where a model factor on resistance of
1.5 was used (following the draft Irish National
Annex). Instead, Repute uses the value 1.75 that
appears in the published version of that Annex.
6. You can check this by selecting the View tab on Repute’s ribbon and then
clicking on the Specify button. Then, select ‘EC7 with Irish NA’ in the Project
Manager to display its properties in the Property Inspector. Expand the
category labelled Options (if necessary) and read the value for Model factor
on resistance.
A Repute project that reproduces Bond and Harris’s calculations can be found in
[Docs]\Examples\Bond and Harris (2008) Ex 13.1.rpx.

Step 9 – change the design standard
In Step 9, you will create a second calculation, identical to the first but based on
the UK National Annex to Eurocode 7.
1. Returning to the Project Manager, create a copy of Calculation 1 by rightclicking on it (under ‘Calculations’) and selecting the Edit > Duplicate
command.
2. With this calculation selected in the Project
Manager, change its Name to ‘Calculation 2’
and its Design Standard to ‘EC7 with UK NA’.
3. In the Project Manager, select the Design
Standard ‘EC7 with UK NA’. Then in the
Property Inspector, set Options > Pile testing
to ‘Investigation tests’. The values of the model
factor and the resistance factors will change.
This setting is appropriate when the calculated
resistance will be checked by static pile load
tests taken to ultimate load.
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4. Run the calculation by selecting the Build tab on Repute’s ribbon and then
clicking on the Run ‘Calculation 2’ button. (If this button is disabled or reads
Run ‘Calculation 1’, then go back to the Project Manager and select
Calculation 2, then re-try.) Your screen will now look something like this:

Step 10 – close the project
In Step 10, you will close and – optionally – save the project. (Note: this is not
available in the Trial Edition.)
1. Display the program’s File Menu and close the project by clicking on Close.
2. If you have made changes to the project since it was last saved, Repute will
ask you if you want to save before proceeding. Answer Yes or No by clicking
the appropriate button.
3. Repute will then (if requested) save and close the project.
[Docs]\Tutorials\Tutorial 3\Tutorial 3.rpx captures everything in
this tutorial.

What’s next?
Tutorial 4 shows how the boundary element method can analyse a pile group.
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TUTORIAL 4
PILE GROUP IN CLAY AND SAND
Tutorial 4 demonstrates how the boundary element method can be used to
analyse a pile group. The worked example involves a group of four bored piles in
stiff clay overlying dense sand:
!

Ground conditions comprise 8m of stiff clay overlying dense sand. Both
soils will be modelled as linear elastic materials.

!

The stiff clay has a vertical Young’s modulus of 40 MPa and a horizontal
modulus of 20 MPa, with Poisson’s ratio equal to 0.5.

!

The dense sand has the same Young’s modulus vertically and
horizontally, equal to 50 + 10z MPa (where z is the depth below the top
of the sand in metres), and Poisson’s ratio equal to 0.3.

!

The bored piles are installed on a 2 x 2 grid, at 3 m spacing (centre-tocentre). Each pile is 20 m long, 1050 mm in diameter, with a Young’s
modulus (vertically and horizontally) of 30 GPa.

!

A characteristic vertical force of 12 MN (permanent), horizontal force of
1 MN (variable), and moment of 2 MNm (variable) are applied at the
centre of the pile group.

!

You want to determine the displacement and rotation of the pile cap
under serviceability conditions.

This tutorial is written for users of the Professional, Enterprise, and Trial Editions
of Repute only. Users of the Standard Edition should look at Tutorials 1-3.

Overview
!

In Step 1, you will use the Project Wizard to enter project information
and create a scenario to represent a persistent design situation.

!

In Step 2, you will use the Pile Group Wizard to create a 2 x 2 pile
group and specify the piles’ properties.

!

In Step 3, you will use the Borehole Wizard to create a borehole
containing stiff clay and dense sand layers.

!

In Step 4, you will enter the stiffness parameters for Soils 1 and 2.

!

In Step 5, you will use the Action Wizard to create the actions applied to
the pile group.

!

In Step 6, you will use the Calculation Wizard to create the calculation
you want Repute to perform.
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!

In Step 7, you will perform the calculation and review the results.

!

In Step 8, you will produce a report summarising the calculation.

!

In Step 9, you will close and (optionally) save the project.

If Repute is not already running, double-click on the Repute icon on Windows’
Desktop to start the program. Once the splash screen has disappeared, Repute
displays its Welcome page.
If you have an existing project open, click Close on the program’s Application
menu. You will be prompted to save your work if you have not already done so.

Step 1 – create the project
In Step 1, you will use the Project Wizard to enter project information and create
a scenario to represent the design situation to be analysed.
1. Open the Project Wizard by
selecting the Wizards tab on
Repute’s ribbon and then clicking on
the Project Wizard button.
2. When the Wizard appears, type
“Tutorial 4” in the Project name box.
Choose the folder where you want
to save this project by using the Path control. If you do not change the setting
here, the file will be saved in your Documents folder.
3. Enter “Pile group in clay and sand” in the Description box and “04” in the
Project ID box.
4. Click Next to display the next page. Since we are not going to use a design
standard, there is nothing to set on this page.
5. Click Next to display the next page. In the table, change the Design Situation
of Situation 1 to “Persistent” (if it is not already set).
6. Click Next to display the final page. If you wish to review any of the settings
you have made, click Back to return to the relevant page.
7. When you are ready, click Finish to generate the project. The Project Wizard
then:
!
!
!

Creates Site 1, Ground Surface 1, and Situation 1
Adds Ground Surface 1 to Situation 1
Creates a new project “Tutorial 4.rpx“ with all of these items

[Docs]\Tutorials\Tutorial 4\Step 1.rpx captures everything so far.
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Step 2 – create the pile group
In Step 2, you will use the Pile Group Wizard to create a 2 x 2 pile group and
specify the piles’ properties.
1. Open the Pile Group Wizard by
selecting the Wizards tab on
Repute’s ribbon and clicking on the
Pile Group Wizard button.
2. When the Wizard appears, choose
the Predefined plan arrangement
and change the Total number of
piles to 4. The picture on the left-hand side of the Wizard will
change to show you the default 2 x 2 pile arrangement.
Change the Spacing between the piles to 3000 mm, but
leave the Cover at its default value (150 mm).
3. Click Next to display the next page. Choose ‘(Cast-in-place
Concrete) Bored Pile’ as the pile type.

4. Click Next to display the next page. Change the Concrete class to C20/25
and the Diameter/Breadth to 1050 mm. (By default, this concrete has Young’s
modulus of 30 GPa but this is not shown.)

5. Click Next to display the next page. Change the Embedded length (L) to 20 m
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but leave the Upstand (U) as 0 m.

6. Click Next to display the next page. Leave all the values on this page as zero –
this will position the pile group centrally in the co-ordinate system (and not
rotated).

7. Click Next to display the next page. Tick
“Situation 1” to add the pile group to the
scenario.
8. Click Next to display the last page. If you
wish to review any of the settings you have
made, click Back to return to the relevant
page.
9. When you are ready, click Finish to
generate the pile group. The Pile Group
Wizard then:
!
!
!
!
!
!

Creates Piles 1-4
Creates Pile Group 1
Creates Concrete 1
Links Piles 1-4 to Concrete 1
Adds Piles 1-4 to Pile Group 1
Adds Pile Group 1 to Situation 1

10. Select Pile Group 1 in the Project Manager
(under “Structural Elements > Pile Groups”),
and double-click to show its properties.
11. Under the heading Pile Cap, enter 1.5 into
the Pile cap thickness editor and press
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ENTER.
[Docs]\Tutorials\Tutorial 4\Step 2.rpx captures everything so far.

Step 3 – create the borehole
In Step 3, you will use the Borehole Wizard to create a borehole containing stiff
clay and dense sand layers.
1. Open the Borehole Wizard by
selecting the Wizards tab on
Repute’s ribbon and clicking on the
Borehole Wizard button.
2. When the Wizard appears, increase
the number of layers to 2.
3. Click Next to display the next page. Change the thickness of Layer 1 to 8 m
and its type to “Clay”. Change the thickness of Layer 2 to 20 m and its type to
“Sand”.

4. Click Next to display the next page. Change the weight density of Soil 1 to
3
18 kN/m but leave its angle of shearing as 25E. Change the weight density of
3
Soil 2 to 21.5 kN/m and set its angle of shearing to 36E. Leave the cohesion
of both soils unchanged at 0 kPa. Click Next to display the next page.

5. Change the undrained strength of Soil 1 to 100 kPa, its increase in strength to
500 kPa, and the distance over which the increase occurs to 8m.
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6. Click Next to display the next page. Since the ground profile does not include
rock, there is nothing to set on this page.
7. Click Next to display the next page. Tick “Situation 1” to add the borehole to
the scenario.
8. Click Next to display the last page. If you wish to review any of the settings
you have made, click Back to return to the relevant page.
9. When you are ready, click Finish to
generate the borehole. The Borehole
Wizard then:
!
!
!
!
!
!
!

Creates Soils 1-2
Creates Layers 1-2
Creates Borehole 1
Links Soil 1 to Layer 1
Links Soil 2 to Layer 2
Adds Layers 1-2 to Borehole 1
Adds Borehole 1 to Situation 1

[Docs]\Tutorials\Tutorial 4\Step
3.rpx captures everything so far.

Step 4 – enter the soils’ stiffness
properties
In Step 4, you will enter the stiffness parameters
for Soils 1 and 2.
1. Select Soil 1 in the Project Manager (under
“Materials”), and double-click to show its
properties.
2. Expand the heading Stiffness > Undrained
Young’s modulus (Eu) > Large strain
stiffness. Under this heading, enter 40 into
the Undrained Young’s modulus editor and
press ENTER.
3. The value of Shear modulus (G) will
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automatically change to show 13.33 MPa, which you can see if you expand
the heading Stiffness > Shear modulus (G) > Large strain stiffness.
4. The Stiffness ratio G1/G0 will change to 13.33%, since the Small strain
stiffness > Shear modulus (G) value is 100 MPa (= G0) and G1 = 13.33 MPa.
5. Near the bottom of the heading Stiffness, type 0.5 into the Anisotropy editor
and press ENTER. The value of undrained Horizontal Young’s modulus (Eh)
will change to 20 MPa (i.e. 40 MPa x 0.5) and the value of Horizontal shear
modulus (Gh) to 6.67 MPa (i.e. 13.33 MPa x 0.5).
6. Next, select Soil 2 in the Project Manager. The Property Inspector will change
to display its properties.
7. heading General, type 8 into the Reference
depth 1 (z,ref1) editor and press ENTER
(this is the top of the soil layer).
8. Type 28 into the Reference depth 2 (z,ref2)
editor and press ENTER (this is the bottom
of the soil layer).
9. Under the heading Stiffness, (if necessary)
type 0.3 into the Poisson’s ratio (v) editor
and press ENTER. The other editors will
show their default values.
10. Under the sub-heading Young’s modulus
(E) > Large-strain stiffness, type 50 into the
Young’s modulus (E) editor and press
ENTER. The Large strain stiffness > Shear
modulus (G) value will automatically
change to show 19.23 MPa, corresponding
to G = E / 2(1 + v).
11. Double-click on the sub-heading Variation with depth (or single-click on the +
button located to the left of it) and type 250 into the E’,ref2 editor and press
ENTER. The Stiffness > Ground Stiffness editor will change to show “Gibson
stiffness” and the value of Young’s modulus gradient (dE/dz) will change to
3
show 10 MN/m .
[Docs]\Tutorials\Tutorial 4\Step 4.rpx captures everything so far.

Step 5 – create forces and moments
In Step 5, you will use the Action Wizard to create loads applied to the pile group.
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1. Open the Action Wizard by
selecting the Wizards tab on
Repute’s ribbon and clicking on the
Action Wizard button.
2. When the Wizard appears, increase
the number of forces to 2; “Force 1”
and “Force 2” will be created. Set
the Fz value for Force 1 to 12000 kN, the Fx value of Force 2 to 1000 kN, and
the Fz value of Force 2 to 0 kN. Change the Variability of Force 1 to
“Permanent”, but leave that for Force 2 as “Variable”.
3. Change the Depth of both forces to –1.5 m.

4. Click Next to display the next page. Increase the number of moments to 1;
“Moment 1” will be created. Set its My value to 500 kNm, leave its Variability
as “Variable”, and set its Depth value to –1.5 m.

5. Click Next to display the next page. Increase the number of combinations to
1; “Combination 1” will be created. Under the column Forces to include...,
tick Force 1 and Force 2. Under the column Moments to include..., tick
Moment 1.
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6. Click Next to display the last page. If you wish to review any of the settings
you have made, click Back to return to the relevant page.
7. When you are ready, click Finish to
generate the actions and their combination.
The Actions Wizard then:
!
!
!
!

Creates Forces 1 and 2
Creates Moment 1
Creates Combination 1
Adds Forces 1 and 2 and Moment 1
to Combination 1

8. Going back to the Project Manager, select
Situation 1 (under Scenarios > Situations).
9. Then, in the Property Inspector, place a tick next to Combination 1 (under
Actions) to add the combination to this scenario. The Drawing Board will
automatically update.
[Docs]\Tutorials\Tutorial 4\Step 5.rpx captures everything so far.

Step 6 – create the calculation
In Step 6, you will use the Calculation Wizard to create the calculation you want
Repute to perform.
1. Open the Calculation Wizard by
selecting the Wizards tab on
Repute’s ribbon and then clicking
the Calculation Wizard button.
2. When the Wizard appears, select
“Boundary Element Analysis”. (The
calculations that appear here
depend on which edition of Repute you are running. The Enterprise Edition
provides more calculations than the Standard and Professional editions.)

50

Geocentrix Repute 2.5 Quick-Start Guide

3. Click Next to display the next page. Since there are no standards to select
from, there is nothing to do on this page.
4. Click Next to display the next page. Select “Situation 1” to link the boundary
element analysis to that scenario.
5. Click Next to display the last page. If you wish to review any of the settings
you have made, click Back to return to the relevant page.
6. When you are ready, click Finish to generate the calculation. The Calculation
Wizard then:
!
!

Creates Calculation 1
Links Calculation 1 to Situation 1

7. Select “Calculation 1” in the Project
Manager (if it is not already selected).
8. In the Property Inspector, under the
heading “Options” change the Stress-strain
model to “Linear-elastic”.
[Docs]\Tutorials\Tutorial 4\Step
6.rpx captures everything so far.

Step 7 – perform and review the
calculation
In Step 7, you will perform the calculation and review the results.
1. Run the calculation by selecting the
Build tab on Repute’s ribbon and clicking
on the Run Calculation 1 button.
2. Repute will perform all the
calculations that are linked to Situation
1 (in this case, just Calculation 1) and
then change its display to show its
Checking Desktop (which displays the Workbook, and Graph Paper). You can
switch to this display at any time by clicking on the Check button on the View
tab of Repute’s ribbon.
3. Your screen will now look something like this:

Tutorial 4: pile group in clay and sand

51

Step 8 – produce a report
In Step 8, you will produce a report summarising the calculation.
1. Switch to
Repute’s Review
Desktop (which
displays the
Reporter and
Project Manager)
by selecting the
View tab of Repute’s ribbon and then clicking on the Review button.
2. Create the report by clicking on the Refresh button located at the top of the
Reporter. Repute will generate the requested report and then show it. You
can navigate around the report using the First Page, Previous Page, Next
Page, and Last Page controls, also at the top of the Reporter.

3. You can choose which elements appear in the report by turning items on or
off via the buttons in the Report Elements group on the Reporter tab.
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4. Finally, you can print the report by clicking on Print button on the Reporter
1
tab.

Step 9 – close the project
2

In Step 9, you will close and (optionally) save the project.
1. Display the program’s File Menu and click Close.

2. If you have made changes to the project since it was last saved, Repute will
ask you if you want to save it before proceeding. Answer Yes or No by
clicking the appropriate button.
3. Repute will then (if requested) save and close the project.
[Docs]\Tutorials\Tutorial 4\Tutorial 4.rpx captures everything in
this tutorial.

What’s next?
Tutorial 5 shows you how to set up a non-linear boundary element analysis of a
pile group in stiff clay overlying rock.

1

You cannot print the project in the Trial Edition of Repute

2

You cannot save the project in the Trial Edition of Repute
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TUTORIAL 5
NON-LINEAR ANALYSIS OF PILE GROUP IN STIFF CLAY
OVERLYING A RIGID LAYER
This tutorial demonstrates non-linear boundary element analysis of a pile group. It
shows you how to:
!

Specify a non-linear analysis

!

Introduce a rigid layer into the calculations

!

Produce a load-displacement graph for the pile cap

!

Print the results of your calculations

The worked example involves the analysis of a group of 4 piles installed in stiff clay
overlying a rgid layer.
!

The ground conditions at the site comprise 35 m of stiff clay (Young's
modulus 75 + 10z MPa vertically and half that horizontally, where z is
the depth below the top of the layer; Poisson's ratio 0.5) overlying a rigid
layer.

!

A non-linear soil model will be used for the clay, with unit weight
3
19.8 kN/m , undrained strength 75 + 10z kPa, and adhesion factor 0.5.

!

The water table is at the ground surface.

!

The piles will be installed on a 2 x 2 grid, at 3 m spacing (centre-to-centre) along the edge of the grid. Each pile is 20 m long, 1.05 m in
diameter, with a free-standing length of 0.5 m and Young's modulus of
30 GPa (both axially and laterally). This is the same pile group as was
used in Step 2 of Tutorial 4.

!

You are interested in the displacements and rotation of the pile cap
under a combined vertical load of 20 MN, horizontal load of 2 MN, and
moment of 3 MNm. The loads will be applied at the centre of the pile
cap.

!

Hyperbolic curve-fitting constants of 0.5 (for the shaft), 0.99 (for the
base), and 0.9 (for lateral response) should be used.

This tutorial is written for users of the Professional, Enterprise, and Trial Editions
of Repute only. Users of the Standard Edition should look at Tutorials 1-3.
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Overview
!

In Step 1, you will use the Project Wizard to enter project information
and create a scenario to represent the design situation to be analysed.

!

In Step 2, you will create four piles and connect them together in a pile
group.

!

In Step 3, you will create a stiff clay and specify its properties.

!

In Step 4, you will create a layer, borehole, and water table.

!

In Step 5, you will create a force, moment, and combination of actions
(to combine the force and moment).

!

In Step 6, you will create the calculation that you want Repute to
perform.

!

In Step 7, you will perform the calculation.

!

In Step 8, you will export results to a Microsoft Excel spreadsheet.

!

In Step 9, you will close and (optionally) save the project.

If Repute is not already running, double-click on the Repute icon on Windows’
Desktop to start the program. Once the splash screen has disappeared, Repute
displays its Welcome page.
If you have an existing project open, click Close on the program’s File menu. You
will be prompted to save your work if you have not already done so.

Step 1 – create the project
In Step 1, you will use the Project Wizard to enter project information and create
a scenario to represent the design situation to be analysed.
1. Open the Project Wizard by
selecting the Wizards tab on
Repute’s ribbon and then clicking
on the Project Wizard button.
2. When the Wizard appears, type
“Tutorial 5” in the Project name
box. Choose the folder where
you want to save this project (for example,‘Repute Projects’) by using the Path
control. (If you do not change the setting here, it will be saved in your
Documents folder.)
3. Enter “Pile group in stiff clay overlying rigid layer” in the Description box.
4. Enter “05” in the Project ID box.
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5. Click Next to display the next page. Since we are not going to use a design
standard, there is nothing to set on this page.
6. Click Next to display the next page. Since the Design Situation of Situation 1
is already set to “Persistent”, there is nothing to change on this page.
7. Click Next to display the final page. If you wish to review any of the settings
you have made, click Back to return to the relevant page.
8. Click Finish to generate the project. The Project Wizard then creates a new
project named Tutorial 5.rpx containing the following items:
!
!
!

Project Information: Site 1
Geometrical Objects: Ground Surface 1
Scenarios: Situation 1

[Docs]\Tutorials\Tutorial 5\Step 1.rpx captures everything so far.

Step 2 – create the pile group
In Step 2, you will create four piles and connect them together in a pile group.
1. Switch to Repute’s
Construction
Desktop by
selecting the View
tab on Repute’s
ribbon and clicking
on the Construct
button. (The Construction Desktop displays the Drawing Board, Project
Manager, and Stockyard.)
2. Right-click anywhere in the Stockyard and select “Concretes” from the pop-up
menu in order to open the Concretes group.
3. Then click on the item labelled “C20/25” and keep the left mouse button
pressed.
4. Drag the cursor away from the Stockyard
towards the Project Manager. The cursor
will change to signal the dragging
operation.
5. Finally, release the left mouse button when
the cursor is located over the Project
Manager to drop the concrete there, where
it will appear as Concrete 1 (under the
heading “Materials”).
6. Back in the Stockyard, click on the heading
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labelled “Structural Elements” to open the Structural Elements group.

7. Then click on the item labelled “Bored Pile” and drag it to the Project
Manager, in the manner described above.
8. Repeat the previous instruction for “Pile Group”.
9. Switch to Repute’s
Specification Desktop
by selecting the View
tab on Repute’s
ribbon and clicking on
the Specify button.
(The Specification
Desktop displays the Drawing Board, Project Manager, and Property
Inspector.)
10. In the Project Manager, select Pile 1 (located under the heading “Structural
Elements”). The Property Inspector will change to show its properties.
11. In the Property Inspector, under the
heading “Location > Relative Position”,
change the pile’s X-position and Y-position
(both) to 1.5 m.
12. Under “Section Properties”, tick the box
Has casing and change the pile’s Shaft
diameter to 1050 mm. The pile’s Base
diameter will change to 1050 mm as well.
13. Under “Material Properties”, select
“Concrete 1” in the Material name box.
14. Finally, under “Dimensions”, change the
pile’s Length to 20 m (if necessary) and its
Free-standing length to 0.5 m.
15. Next, duplicate Pile 1 by right-clicking on it
in the Project Manager and selecting the
Edit > Duplicate command. “Pile 1 - Copy”
will appear in the Project Manager and its
properties in the Property Inspector.
16. In the Property Inspector, change the
Name of the new pile to “Pile 2” and its Xposition to !1.5 m. Press ENTER to confirm
the change in position. Leave all its other
properties unchanged.
17. Duplicate Pile 2 by right-clicking on it in the
Project Manager and selecting the Edit >
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Duplicate command (or, quicker, by pressing CTRL+D).
18. In the Property Inspector, change the Name of the new pile to “Pile 3” and its
Y-position to !1.5 m and press ENTER. (Note, its X-position will also be
!1.5 m.)
19. Finally, duplicate Pile 3, change its Name to “Pile 4”, and its X-position to
+1.5 m. (Its Y-position will be !1.5 m.)
20. In the Project Manager, select Pile Group
1.
21. In the Property Inspector, under the
heading Location > Absolute Position,
change the Level of the pile group to 0.5 m
and press ENTER.
22. Place ticks next to all four piles and click the
Resize button under the heading Pile Cap.
The dimensions of the pile cap will change
to reflect the piles’ new positions.
23. Under the heading Pile Cap, change the
Pile cap thickness to 1.25 m and press
ENTER.
24. Lastly, select Situation 1 (under “Scenarios >
Situations”) in the Project Manager and tick
“Pile Group 1” in the Property Inspector to
add the pile group to the scenario.
25. In this step you have:
!
!
!
!
!

Created Concrete 1, Pile 1, and Pile Group 1
Linked Pile 1 to Concrete 1
Duplicated Pile 1 to create Piles 2, 3, and 4 and changed their locations
Added Piles 1-4 to Pile Group 1
Adds Pile Group 1 to Situation 1

The Drawing Board will now look something like this. Note that the pile cap
appears in yellow, since we have not specified a material to link to this element.
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[Docs]\Tutorials\Tutorial 5\Step 2.rpx captures everything so far.

Step 3 – create the soil
In Step 3, you will create a stiff clay and specify its
properties.
1. Open the Stockyard‘s Grounds group by selecting
the Insert tab on Repute’s ribbon and clicking on the
Ground button.
2. When the Stockyard appears, click on the
item labelled “Clay” and keep the left
mouse button pressed.
3. Drag the cursor away from the Stockyard
towards the Project Manager. The cursor
will change to signal you are dragging.
4. Finally, release the left mouse button when
the cursor is located over the Project
Manager to drop the clay there, where it will appear as Soil 1 (under the
heading “Materials > Soils”).
5. Next, open the Property Inspector for “Soil 1” by double-clicking on it within
the Project Manager.
6. Under the heading General, type 35 into the Reference depth 2 (z,ref2)
editor and press ENTER (this is the bottom of the soil layer).
7. Under the heading Classification, if necessary untick Strict validation.
8. Under the heading Mass/weight densities, change the clay’s Weight density
3
to 19.8 kN/m .
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9. Under the heading Strength > Undrained
strength, change the clay’s Undrained
strength to 75 kPa.
10. Double-click on the heading Variation with
depth (or single-click on the + button
located to the left of it). Enter 425 kPa into
the box cu,ref2. The undrained strength
3
gradient (dcu/dz) will change to 10 kN/m .
11. In the Property Inspector, near the bottom
of the Stiffness group, type 0.5 into the
Anisotropy editor and press ENTER.
12. Find the heading Undrained Young’s
modulus (Eu) > Small strain stiffness. Type
75 into the Undrained Young’s modulus
(E) editor and press ENTER. The value of Eu
at large strain stiffness will automatically
change to 15 MPa, keeping the Stiffness
ratio G1/G0 (and hence Eu1/Eu1) at its
current value of 20%.
13. Since the soil’s anisotropy was previously
set to 0.5, the Horizontal Young’s modulus
(Eh) becomes 37.5 MPa (i.e. 75 MPa x 0.5).
14. Under the heading Undrained Young’s
modulus (Eu) > Small strain stiffness,
double-click on the sub-heading Variation
with depth (or single-click on the + button
located to the left of it).
15. Enter 425 MPa into the Eu,ref2 editor and press ENTER. The value of the
3
Young’s modulus gradient (dE/dz) will change to 10 MN/m .
[Docs]\Tutorials\Tutorial 5\Step 3.rpx captures everything so far.

Step 4 – create a layer, borehole, and water table
In Step 4, you will create a layer and borehole to
hold the stiff clay and a water table (at ground
surface).
1. In the Stockyard, open the Geotechnical
Constituents group and then create a Soil
Layer, a Rigid Layer, a Borehole, and a
Ground Water Table by dragging-anddropping these items from the Stockyard to
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the Project Manager.

2. Add the water table to the scenario by dragging it from the Project Manager to
the Drawing Board.
3. Select Layer 1 in the Project Manager and then, in the Property Inspector,
change its Thickness to 35 m and select “Soil 1” in its Soil box.
4. Now select Borehole 1 in the Project Manager and, in the Property Inspector,
press the Select... button.
5. In the dialog box that appears, click on the >> button to move Layer 1 and
Layer 2 from the Available layers box to the Selected layers box. Click OK to
confirm the changes.

6. Select Situation 1 in the Project Manager.
7. Finally, in the Property Inspector, tick “Borehole 1” to add it
to the scenario. The borehole will appear on the left-hand
side of the Drawing Board.
8. In this Step you have manually:
!
!
!
!
!

Created Layers 1-2, Borehole 1, and Water Table 1
Added Water Table 1 to Situation 1
Linked Soil 1 to Layer 1
Added Layers 1-2 to Borehole 1
Added Borehole 1 to Situation 1

[Docs]\Tutorials\Tutorial 5\Step 4.rpx captures
everything so far.

Step 5 – create forces and moments
In Step 5, you will create a force, moment, and combination of
actions (to combine the force and moment).
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1. In the Stockyard, open the
Actions group and then
create a Force, a Moment,
and a Combination of
Actions by dragging-anddropping these items from
the Stockyard to the Project
Manager.
2. Select Force 1 in the Project Manager.
3. In the Property Inspector, change the force’s Level (under the heading
Location > Absolute Position) to 1.75 m, its Fx value to 2000 kN, and its Fz
value to 20 000 kN. The Depth will change to –1.75 m and the Resultant to
20 099.75 kN as you do this. (The change in level is necessary to place the
force on top of the pile cap.)
4. Select Moment 1 in the Project Manager.
5. In the Property Inspector, change the moment’s Level to 1.75 m ut leave its
My value as 500 kNm.
6. Select Combination 1 in the Project Manager.
7. In the Property Inspector, tick both Force 1 and Moment 1. Make a note of
the Fx, Fz, and My values (these are resolved about the combination’s current
location). Then change the Level of Combination 1 to 1.75 m. The My value
will change automatically as the lever arm of the forces has changed.
8. Select Situation 1 in the Project Manager.
9. Finally, in the Property Inspector, tick “Combination 1” to add it to the
scenario. Arrows will appear on the Drawing Board above the pile group.
10. In this Step you have manually:
!
!
!

Created Force 1, Moment 1, and Combination 1
Added Force 1 and Moment 1 to Combination 1
Added Combination 1 to Situation 1

[Docs]\Tutorials\Tutorial 5\Step 5.rpx captures everything so far.

Step 6 – create the calculation
In Step 6, you will create the calculation you want Repute to perform.
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1. In the Stockyard, open the
Calculations group by rightclicking and selecting
‘Calculations’ from the popup menu.
2. Create a Boundary Element
Analysis by dragging-anddropping this item from the
Stockyard to the Project Manager.
3. In the Property Inspector, under the heading Links, change the Scenario to
“Situation 1”. Then, under Options, change the Drainage condition to
Undrained and the Stress-strain model to ‘Hyperbolic’.
4. In this Step you have:
!
!

Created Calculation 1
Linked Situation 1 to Calculation 1

[Docs]\Tutorials\Tutorial 5\Step
6.rpx captures everything so far.

Step 7 – perform and review the
calculation
In Step 7, you will perform the calculation.
1. Run the calculation by selecting the
Build tab on Repute’s ribbon and clicking
on Run Calculation 1.
2. Repute will perform the calculation and
then change its display to show its
Checking Desktop (displaying the
Workbook and Graph Paper panels).
You can switch to this display at any time by clicking on the Check button on
Repute’s View tab.
3. Your screen will now look something like this:
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Step 8 – export the results
In Step 8, you will export results to a Microsoft Excel spreadsheet.
1. Right-click in the Workbook panel to reveal its context menu and select
Export. Only the data that is currently displayed in the Workbook will be
exported. To include other results, click on the Asterisk (*) in the top left corner
of the Workbook’s table and select the results you want to include.
2. Select the desired path for the file, enter its name, and then click on the Save
button. This will save the data in an Excel spreadsheet (*.xls file).
3. You can then view the results by navigating to this folder using Windows’ File
Manager and opening the file in Excel. The results should look like the image
below (if opened in Excel 2016).
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Step 9 – close the project
In Step 9, you will close and – optionally – save the project. (Note: this is not
available in the Trial Edition.)
1. Display the program’s File Menu and click Close.
2. If you have made changes to the project since it was last saved, Repute will
ask you if you want to save it before proceeding. Answer Yes or No by clicking
the appropriate button.
3. Repute will then (if requested) save and close the project.
[Docs]\Tutorials\Tutorial 5\Tutorial 5.rpx captures everything in
this tutorial.

What’s next?
Tutorial 6 looks at the more complicated case of an asymmetric pile group under
3-dimensional loading.
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TUTORIAL 6
ASYMMETRIC PILE GROUP UNDER 3D LOADING
Tutorial 6 considers a more complicated project: that of an asymmetric pile group
under general 3-dimensional loading. This tutorial shows you how to:
!

Modify an existing project

!

Change the location of individual piles within a pile group

!

Specify 3D loading

The worked example involves the analysis of a group of 15 piles installed in stiff
clay overlying dense sand.
!

The ground conditions at the site are identical to those in Tutorial 5.

!

The piles will be installed on an irregular grid, shown below. The spacing
between adjacent rows is 3 m in the X-direction and 1.5 m in the Y.

!

Each pile is 20 m long, 1 m in diameter, and has a Young's modulus of
30 GPa (both axially and laterally).

!

You are interested in the displacements and rotation of the pile cap
under a combined vertical load of 50 MN, horizontal loads of 10 MN (in
the X-direction) and 7 MN (in the Y-direction), and moments of 5 MNm
(in the XZ-plane) and 3 MNm (in the YZ-plane). The vertical load will be
applied on the pile cap at the location of Pile 9.

This tutorial is written for users of the Professional, Enterprise, and Trial Editions
of Repute only. Users of the Standard Edition should look at Tutorials 1-3.
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Overview
!

In Step 1, you will open and modify an existing project.

!

In Step 2, you will delete the old pile group and then specify a new
group.

!

In Step 3, you will move the piles to their final (asymmetric) positions.

!

In Step 4, you will modify the actions on the pile group.

!

In Step 5, you will perform the calculation and review the results.

!

In Step 6, you will close and (optionally) save the project.

If Repute is not already running, double-click on the Repute icon on Windows’
Desktop to start the program. Once the splash screen has disappeared, Repute
displays its Welcome page.
If you have an existing project open, click Close on the program’s Application
menu. You will be prompted to save your work if you have not already done so.

Step 1 – open and modify an existing project
In Step 1, you open an existing project and modify its project information.
1. Click on the File > Open command and, in the dialog box that appears,
navigate to the folder [Docs]\Tutorials\Tutorial 6 and select the file
Tutorial 4.rpx (this is a copy of the file that was saved at the end of
Tutorial 4). Click on the Open button to open this project.

2. In the Project Manager, double-click on “Site 1” to display its properties in the
Property Inspector. Then, in the Property Inspector, change the Description to
“Asymmetric pile group under 3D loading” and the Project ID to “06”.
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3. Save the project under a different name, by clicking the File > Save As
command and then clicking on Repute 2 file.

4. In the dialog box that appears, change the File name to “Tutorial 6” and click
on the Save button to save the modified project with a new name. It will
automatically be saved in the folder [Docs]\Tutorials\Tutorial 6
unless you choose another location for it.
[Docs]\Tutorials\Tutorial 6\Step 1.rpx captures everything so far.

Step 2 – specify a new pile group
In Step 2, you will delete the old pile group and then specify a new group.
1. The pile group specified in Tutorial 4 was a 2 x 2 group. You can see this most
easily by changing the orientation of the Drawing Board to plan view. To do
this, right-click anywhere on the Drawing Board and select Plan. Alternatively,
select the Drawing Board tab on Repute’s ribbon and then click on the Plan
button.
2. You may also find it easier to see the piles if you increase the Drawing Board’s
scale. To do this, right-click anywhere on the one of the rulers at the edge of
the Drawing Board and select 1:100. Alternatively, there are buttons on the
Drawing Board tab (on Repute’s ribbon) which allow you to manipulate the
scale however you choose.
3. If you move the mouse over the drawing of the pile group in
the Drawing Board, a balloon will appear showing its name
(which is “Pile Group 1”). You can select this group by
clicking on it, whereupon a blue selection rectangle will
appear with square “handles” at each corner. “Pile Group 1”
will automatically be highlighted in the Project Manager. You
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can display its properties in the Property Inspector by clicking on the Pile
Group in the Project Manager.

4. De-select the pile group by holding the CTRL-key down and clicking on the
drawing of the group. The handles will disappear and the Pile Group will be
de-selected (and no longer highlighted) in the Project Manager.
5. If you now move the mouse over one of the piles within the
group, a balloon will appear showing the pile’s name (e.g.
“Pile 4”). You can select this pile by clicking on it,
whereupon a blue selection rectangle will appear with
square “handles” at each corner. “Pile 4” will automatically
be highlighted in the Project Manager and its properties
displayed in the Property Inspector.
6. To delete all the piles from the project, hold the CTRL key down and select
each pile in turn in the Project Manager. Then, right-click to display the Project
Manager’s pop-up menu, and select the Edit > Delete command. You will be
reminded that Pile 1 is being used by Pile Group 1 and prompted to confirm
its deletion. Click Yes to All to delete all the piles from the project. They will
disappear from both the Project Manager and the Drawing Board.

7. Repeat the previous step for Pile Group 1 to delete it from the project.
8. Open the Pile Group Wizard by selecting the Wizards tab on Repute’s ribbon
and clicking on the Pile Group Wizard button.
9. When the Wizard appears, choose the Custom plan arrangement and change
the number of pile rows to m = 5 by n = 3. The picture
on the left-hand side of the Wizard will change to show
you a (generic) rectangular pile arrangement.
10. Change the X Spacing and Y Spacing to 3000 mm, but
leave the Cover at its default value (150 mm).
11. Click Next to display the next page. Choose ‘(Cast-inplace) Bored Pile’ as the pile type.
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12. Click Next to display the next page. Change the Concrete class to C20/25 and
the Diameter/Breadth to 1050 mm. By default, the concrete will be assigned a
Young’s modulus of 30 GPa.

13. Click Next to display the next page. Change the Embedded length (L) to 20 m
but leave the Upstand (U) as 0 m.

14. Click Next to display the next page. Change the X position (dX) of the pile
group‘s centroid to 6 m, its Y position (dY) to 3 m but leave its Rotation (d2)
as 0E. This will move the piles in the group close to their desired positions.

15. Click Next to display the next page. Tick “Situation 1” to add the pile group to
the scenario.
16. Click Next to display the last page. If you wish to review any of the settings
you have made, click Back to return to the relevant page.
17. When you are ready, click Finish to generate the pile group. The Pile Group
Wizard then:
!

Creates Piles 1-15
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!
!
!
!
!

Creates Pile Group 1
Creates Concrete 2
Links Piles 1-15 to Concrete 2
Adds Piles 1-15 to Pile Group 1
Adds Pile Group 1 to Situation 1

The Drawing Board will now look something like this:

[Docs]\Tutorials\Tutorial 6\Step 2.rpx captures everything so far.

Step 3 – move the piles to their final positions
In Step 3, you will move the piles to their final (asymmetric) positions.
1. Select “Pile 2” in the Project Manager and
then, in the Property Inspector, change its
Y-Position to !1.5 m and press ENTER. The
pile’s position on the Drawing Board will
change automatically.
2. Repeat the previous instruction for Pile 4.
3. Next, change the Y-Position of Piles 7 and 9
to +1.5 m; the Y-Position of Piles 12 and 14
to +4.5 m; and the X- and Y-Position of Pile
15 to +3.0 m and +7.5 m (respectively).
4. Select “Pile Group 1” in the Project
Manager.
5. In the Property Inspector, under the heading Pile Cap, click on the Resize
button to enlarge the pile cap. The Drawing Board will now look something
like this:
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A copy of this step can be found at [Docs]\Tutorials\Tutorial 6\Step
3.rpx.

Step 4 – modify the loads
In Step 4, you modify the actions on the pile group.
1. Select “Force 1” in the Project Manager
and then, in the Property Inspector, change
Fz to 50000 kN, select “Pile 8” in the Tether
to ... box, and change the Depth to 0 m.
2. Select “Force 2” and change its Fx to
10000 kN, Fy to 7000 kN, select “Pile 8” in
the Tether to ... box, and change the Depth
to 0 m. As you do this, the force’s
orientation and position will change
automatically on the Drawing Board.
3. Select “Moment 1” and change its Mx to
3000 kNm, My to 5000 kNm, select “Pile 8”
in the Tether to ... box, and change the
Depth to 0 m.
4. Finally, select “Combination 1” and change
its X-position to 6 m, Y-position to 3 m, and
Depth to 0 m. Again, as you do this, the
combination’s orientation and position will
change automatically and the various
components of action displayed in the
Property Inspector will also change.

72

Geocentrix Repute 2.5 Quick-Start Guide

5. The Drawing Board will now look something like this:

[Docs]\Tutorials\Tutorial 6\Step 4.rpx captures everything so far.

Step 5 – perform and review the calculation
In Step 5, you will perform the calculation and review the results.
1. Select Calculation 1 in the Project
Manager and then, on the Build tab, click
on the button labelled Run Calculation
1.
2. Repute will perform the calculation and
then change its display to show its
Checking Desktop (which displays the Workbook and the Graph Paper). You
can switch to this display at any time by clicking on the Check button on the
View tab.
3. Your screen will now look something like this:
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4. You can change the graph that appears on the screen by selecting the Graph
Paper tab on Repute’s ribbon and clicking on the any of the available graphs
that are listed there.

5. For example, if you click on the Moment My button, the graph will change to
look something like this:

6. You can change the appearance of the graph by experimenting with the
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extensive set of controls provided via its Options box. To display the Graph
Options box, click on the Options button on the graph paper tab. Click on the
help button to find instructions for using this box to customize your graph.

Step 6 – close the project
In Step 6, you will close and – optionally – save the project. (Note: this is not
available in the Trial Edition.)
1. Display the program’s File Menu and click Close.
2. If you have made changes to the project since it was last saved, Repute will
ask you if you want to save it before proceeding. Answer Yes or No by clicking
the appropriate button.
3. Repute will then (if requested) save and close the project.
[Docs]\Tutorials\Tutorial 6\Tutorial 6.rpx captures everything in
this tutorial.

What’s next?
Further information about the program’s capabilities can be found in the Repute
2.5 User Manual and the program’s built-in help system. Details of the theory that
underpins the program’s calculations can be found in the Repute 2.5 Reference
Manual.
Further resources are available from the Geocentrix website:
www.geocentrix.co.uk/repute

